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Chapter 14:  Controlled Remote Tug Telemetry 

Overview 
The WinFrog Controlled Remote Tug Telemetry module (also called Remote Control) and 

the WinFrog Remote package enable one central WinFrog system to track other vehicles in the 

work area, with WinFrog systems installed on them, and to control the configuration and 

operation of the WinFrog systems on them. The central WinFrog, or controller, then provides 

the appropriate vehicle information to selected remotes to enable them to monitor and track the 

vehicles it is deemed necessary for them to see. This vehicle information includes fairlead 

information and anchor location and status, thus the remote WinFrog systems are able to display 

anchor patterns, live anchors, and the associated anchor cables. This provides an operational 

area safety factor in addition to the convenience of operating all WinFrog systems from one 

controller. Note: there is only one controller in a given network. 

Both the Controlled Remote Tug Telemetry module and the WinFrog Remote system require 

a communications medium to operate. However, the Remote Control module is able to operate 

over a TCP/IP network using socket connections and the WinFrog Multi-Vehicle Positioning 

and Telemetry (MVP&T) system (see the MVP&T chapter). The WinFrog Remote can only 

operate using the WinFrog Telemetry. 

The Remote Control capability has a number of possible uses but has been developed primarily 

to support work vessels in construction, such as anchor handling tugs for pipe lay projects or 

structure float outs and placements. A typical configuration has a pipe lay barge/vessel 

operating as the controller and the anchor handling tugs as the remote sites. The surveyor at the 

controller is able to control the basic system configurations and operations of the remote sites, 

thus providing the tug’s crews with operational information such as that required for the 

deployment and recovery of anchors without the requirement of having survey personnel 

onboard the tug. 

Communication redundancy is also supported when using WinFrog Telemetry. Installation of 

2 radio-modems on each vehicle, operated at different frequencies, with both being added to 

WinFrog at each site enables WinFrog to provide redundancy for Controlled Remote 

operations. No operator intervention is required at the Remote site while the operator controls 

which radio group to use from the Controller. 

Note: In order to use socket connections, the computers must be have the TCP/IP protocol 

installed and correctly configured. Refer to the Windows
TM

 documentation for necessary 

installation and configuration instructions. 

The following summarizes the capabilities of the Controller with the Remote Control option: 

Configurations 

Vehicle Positioning 

Parameters Configuration of the vehicle positioning 

parameters as accessed via the Configure 

Vehicle-Devices dialog with the exception of 

the addition and removal of data types using the 
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Add and Delete buttons and setting the Data 

Source. It does include the filter selection and 

associated settings, dead reckoning, gating, etc. 

Device (Data Type) 

Configuration  Configuration of the data types attached to the 

vehicles including the antenna offsets, 

Primary/Secondary settings, graphics on, and 

accuracy. Note: this data type configuration is 

the same as that performed from the Configure 

Vehicle-Devices dialog with the Edit button, not 

from the I/O Devices window. 

Vehicle Presentation 

Configuration Configuration of all aspects of the vehicle 

presentation as accessed with the Vehicle 

Presentation dialog. 

Vehicle Shape Configuration of the graphic representation of 

the vehicle as accessed via Configure Vehicle 

Outline dialog. 

Vehicle Offsets Configuration of the vehicle offsets and 

selection of the offset to use with the Configure 

Offsets dialog. 

Waypoint Selection Configuration of the waypoint selection for the 

remote vehicle. Note: any files directly accessed 

for the selection of this point are those in use at 

the control site, not the remote site. Once 

selected, the actual waypoint data are 

transferred. 

Line Selection Configuration of line selection for the remote 

vehicle. Note: any files directly accessed for the 

selection of this point are those in use at the 

control site, not the remote site. Once selected, 

the actual line data are transferred. 

Graphics Configuration Configuration of the Graphics window 1 at the 

remote site. It is expected that this is the only 

open window. If more are open, it is assumed 

that the operator at the remote site is 

knowledgeable enough to manipulate them. The 

control extends to all components of the 

standard graphics configuration (with the 

exception of chart control) including zoom in, 

zoom out, and pan. It is possible to select an 

option to display the remote graphics 

configuration at the control site using Graphics 

window 1 to ensure the remote site graphics are 

providing the necessary information. It should 

be noted that any change in the graphics 

configuration, scale, or centering made at the 

remote is automatically sent back to the control 

system to keep the two systems synchronized. 
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Event Configuration Configuration of the eventing at the remote site. 

It should be noted that even though the event 

data can be configured to be sent to the control 

site for monitoring, all data logging is 

accomplished at the remote site. 

Data Transmissions 

Remote Position Transfer Configuration of the transmission interval of the 

Remote station’s positional information to the 

Controller. These data are used to track the 

Remote at the Controller. 

Remote Data Transfer Configuration of the transmission interval of the 

Remote station’s raw device data to the 

Controller. This permits troubleshooting 

capabilities of the Remote’s system from the 

Controller. 

Remote Event Data Transfer Configuration of the transmission interval of the 

Remote’s Event data to the Controller. This 

enables monitoring of the eventing process 

configured for the Remote. 

General Position Transfer Selection of the vehicles whose positional 

information will be transmitted to a Remote to 

enable it to track vehicles other than itself. 

File Transmissions 

Working Waypoint File The Controller’s current Working Waypoint 

file can be transmitted to a selected Remote 

which will then automatically use it as it’s 

Working Waypoint file. 

Working Line File The Controller’s current Working Line file can 

be transmitted to a selected Remote which will 

then automatically use it as its Working Line 

file. 

Working Picture File The Controller’s current Working Picture file 

can be transmitted to a selected Remote which 

will then automatically use it as its Working 

Picture file. 

Security 
It is important to note that the standard WinFrog license has full Controller capability. The 

Remote Control feature is controlled by the license or modules available on the remote 

WinFrog vessels. That is, the WinFrog on the remote vehicles must either be licensed to use the 

Controlled Remote Tug Telemetry module or actually be the WinFrog Remote package. 
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Remote Sites 
WinFrog with the Controlled Remote Tug Telemetry Module 
versus the WinFrog Remote Package 
WinFrog with the Controlled Remote Tug Telemetry module (also known as Remote Control) 

operates the same way as the WinFrog Remote package with respect to the remote control 

application itself. Therefore, with the exception of the first steps followed in the case of starting 

the Controlled Remote Tug Telemetry module, the use of both is the same from an operator’s 

perspective. The exception to this is that the WinFrog Remote package cannot be accessed 

over a TCP/IP network. 

When running WinFrog with the Controlled Remote Tug Telemetry module, the operator 

must configure WinFrog to operate as a Remote via the main menu. The WinFrog Remote 

package automatically runs as a Remote. 

WinFrog with the Remote Control module has all WinFrog functionality, including the ability 

to configure and track multiple local vehicles. The WinFrog Remote package supports a single 

local vehicle and has restricted functionality in keeping with its purpose of providing basic 

navigational and positional functionality on a remote vessel without a trained operator. 

Remote Control with Telemetry versus TCP/IP Network 
The differences between the operation of the Remote Control module at the remote site with a 

TCP/IP network and telemetry are as follows: 

 For operation with the telemetry, a telemetry device must be added to the 

Remote WinFrog and configured accordingly. This is not required for TCP/IP 

network. 

 For operation with a TCP/IP network, the computers on the network must be 

configured to use the TCP/IP protocol and the IP address of the Remote 

WinFrog systems must be determined. This is not required for the telemetry. 

 When operating with the TCP/IP network, a listener window is opened 

automatically. Closing this will disconnect the network connection 

(irrecoverably, except by exiting and re-running WinFrog). However, closing 

the device window will not affect the telemetry application. 

 The TCP/IP network transfers data at a much higher rate than the telemetry units. 

Configuring a Remote Site 
It is important to note that for the purpose of setting up the Remote WinFrog, with the 

exception of a single step, you proceed as if setting up a normal WinFrog. In the case of the 

WinFrog Remote package, this setup is for a single vehicle operation, that vehicle being the 

one on which the system is installed. 

The following provides an overview for setting up the Remote WinFrog with references to the 

chapters of this manual that cover the topics in steps. 

To Configure a Remote Site 

1 Start the WinFrog as installed on the Remote vehicle. If this is a WinFrog Remote 

package, proceed to step 3. 
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Note: A remote requires a security key in order to operate, whether it is a standard WinFrog 

with the Controlled Remote Tug Telemetry module or the WinFrog Remote package. 

2 Configure Controlled Remote Mode (WinFrog only). 

From the main menu Configure item, select Controlled Remote Mode. You will 

be warned that changing the Controlled remote Mode will affect existing 

connections. Select Yes to proceed.  

The Configure Controlled Remote dialog will appear. 

 

Select either Controlled Remote (Telemetry) or Controlled Remote (Sockets) as required 

for the application. Click OK to apply the change. A message will be presented confirming 

the mode change made. 

3 Configure the geodetics and units. 

This is very important because the geodetics and units cannot be configured via the Remote 

Control option from the Controller. 

See the Configuring Geodetics and Units chapter for details. 

4 Setup the working directories. 

See the Working Directories chapter for details. 

5 Assign working files.  

See the Working Files chapter for details. 

Note: The transfer of picture files, line files, and waypoint files by telemetry can be a time 

consuming process, so it is best to load the initial files at this stage. 

6 Create the local vehicle(s) as required for operations on the vessel on which the system is 

installed. 

See the Vehicles chapter for details. 

7 From the Configure Vehicle-Devices dialog, select Real-Time as the Data Source. While 

there is no need to configure the other parameters as this can be done later from the control 
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site (the exception to this is detailed in Step 8 below) it is recommended that the 

configuration be performed in its entirety. 

Note: The vehicle name, in conjunction with Ship ID or TCP/IP address, is used to identify 

the remote from the controller. This comparison is exact, including being case sensitive. 

Therefore, it is critical to note the name(s) exactly as entered at the Remote in order that the 

Controller can be configured to connect to this remote. In the case of WinFrog, the 

Controller can connect to any of the Remote’s local vehicles. 

8 Add devices. 

See the Peripheral Devices chapter for details. 

The adding of devices and the associated configuring of them, including the communication 

parameters and any device specific configuration, must be executed at the Remote as these 

tasks cannot be performed remotely from the Controller.  

Note: In order to access the Configure Device window, place your cursor in the device tree 

portion of the I/O Devices window, click the right mouse button, and choose the Configure 

Device option. 

If the remote is to be controlled via telemetry, the WinFrog telemetry device must be added 

at this stage (see the Multi-Vehicle Positioning & Telemetry chapter). There is no device 

associated with the TCP/IP connection. 

9 Attach the data types (GPS, Position, Gyro, Heading, etc.) to the vehicle.  

This must be performed at the Remote because it cannot be done from the Controller. 

Available telemetry data types are not to be attached. For the Remote Control feature, the 

telemetry is associated with the system, not a specific vehicle. 

Note: The exception to this is if the telemetry is providing RTCM corrections that are then 

to be used in a WinFrog pseudorange solution for GPS Positioning at the Remote. In this 

case, the telemetry data type DGPS-CORs is attached to the vehicle. However, it is 

recommended that at the Remote, the RTCM corrections be output directly to the GPS 

receiver and the DGPS position from this receiver be used for the Remote positioning. This 

is due to two reasons. The first is that the configuration of the PSEUDORANGE data type 

is not currently supported by the Controller/Remote interface. Secondly, the DGPS 

positioning at the Remote using a single DGPS Reference Station solution directly from a 

GPS receiver is less complicated to setup and monitor, and thus better suited for Remote 

WinFrog operation. It will meet the accuracy requirements for the majority of remote 

vessel operations. 

See the Vehicles chapter for details. 

10 It is recommended that a configuration file be created at this point. (Use the File > System 

Config File… Save option.) This can be accessed at a later time to reset the Remote 

WinFrog to the correct remote settings and state, if required. 
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Remote Site Operation 
When the Remote WinFrog system boots up, regardless of how the system was exited with 

respect to open windows, only the Graphics1 and Vehicle1 windows open and fill the screen. It 

is expected that these will meet the requirements of the navigation and vehicle tracking at most 

Remote WinFrog systems. A standard WinFrog run as a remote boots up as a normal standard 

package with all windows as they were when WinFrog was last exited. 

If the remote is running in TCP/IP network mode, a window will open in the top left of the screen 

behind the Graphics window. The socket connection is associated with this window and would 

be lost if this window was closed. Therefore, this window cannot be closed. 

It is intended that operator action is not required nor, other than the manipulation of Graphics1 

window, is it expected. However, on some vessels the ship’s personnel will be knowledgeable 

about computers and may wish to take advantage of having a navigation and positioning 

package onboard. This will not impact the operation of the Remote WinFrog as a remote 

unless changes are made to those components critical to the operation as a remote or operation 

in general. These critical areas are as follows: 

 Adding, removing, and editing of devices, especially the Telemetry device if 

the communications between the Controller and the Remote is via telemetry. 

 Attaching and removing of data types to and from a vehicle. If the configuration 

of the data types is changed, this can be addressed from the Controller. 

 Modifying the geodetics. 

 Do not remove any Controlled Remote vehicles (this is controlled by the 

controller). 

 Do not change the data source for any Controlled Remote vehicles. 

 

In the case of a standard WinFrog being run and operated by trained personnel but utilizing the 

controlled remote option to support a connection to another vehicle, operational constraints are 

fewer and less critical. The issues to be aware of are as follows: 

 Do not change the name of the vehicle that is being used for the connection. 

 Do not add any telemetry device data items to any vehicles. 

 Do not remove any Controlled Remote vehicles (this is controlled by the 

controller). 

 Do not change the data source for any Controlled Remote vehicles. 

 

Note: changes to the Remote WinFrog are not sent back to the Controller, with the exception 

of changes to the Graphics1 window. Any changes made to the configuration of this window, 

including the actions initiated from the toolbar buttons, such as Zoom In, and any changes 

made from the configuration dialog are transmitted to the Controller to maintain 

synchronization of the graphics configuration. 

Note: As mentioned in the setup procedure, it is recommended that after the Remote is originally 

setup, a configuration file be created using File > System Config File… > Save. Thus, should the 

Remote WinFrog become corrupted from operator interference, the operator can be instructed to 

load this configuration file using the File > System Config File… >Load option. This will reset the 

Remote WinFrog to the correct state for Remote Control operation. 
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Remote Site Telemetry Redundancy 
The Remote site supports redundancy with respect to the TELEMETRY device driver. All 

TELEMETRY device drivers added to WinFrog at the Remote site are checked for messages from 

the Controller. Any messages from the Remote to the Controller are sent over all these devices. The 

TELEMETRY device in use is determined by the configuration of the respective Controlled 

Remote window. In this way, the Remote site is able to utilize whatever TELEMETRY device is 

being used without any operator intervention, thus providing redundancy for the Controlled Remote 

communications. 

Control Sites  

Operation Overview 
The Controller is a standard WinFrog system and is configured as such. It is also secured in the 

usual manner. 

If the Remotes are to be accessed via telemetry, the Telemetry device must be added to 

WinFrog and configured (see the Multi-Vehicle Positioning & Telemetry chapter). No 

telemetry data types are attached to any vehicles. 

If the Remotes are to be accessed using a TCP/IP network, there is no device associated with 

the Controller/Remote communications to be added. However, the Controller computer must 

have the TCP/IP protocol installed and correctly configured. 

The operation of WinFrog as a Controller is enabled when you open up one of up to ten 

Controlled Remote windows. It is from this window that the connection to a Remote is 

configured and established. The subsequent control of the Remote and the data flow between 

the Controller and the Remote is also handled via this window. One window is required for 

each Remote and must be kept open (though it can be minimized) in order to maintain the 

connection. Thus, up to ten Controlled Remote WinFrogs can communicate with the 

Controller simultaneously. 

Once connected, control of the remotes can also be executed from the other display windows 

(see the Operator Display Windows chapter). For example, a waypoint can be selected from 

the Setup Waypoint Tracking dialog box accessed via the Vehicle Text window when the 

desired Remote vehicle is displayed in the window (click the right mouse button and click the 

Setup Waypoint Tracking option). 

Note: the changes made to a Remote from the Controller are not reflected at the Controller 

until confirmation is received from the Remote that the configuration change was received and 

applied. It is important to note that you can manually initiate all processes, even those 

performed automatically during the connection process, such as querying the Remote for its 

vehicle data type list and the associated configurations (Sys Config button). 

The Controlled Remote Window 
The Controlled Remote window provides the connection to the Remote. As soon as it is 

opened or loaded from either an ini or cfg file, it attempts to make a connection to its Remote. If 

it is unsuccessful, it repeats the attempt every minute indefinitely. 
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For a set of Controlled Remote windows configured to use the same telemetry device (cell), 

only one Controlled Remote window can attempt to connect at one time. All the other 

Controlled Remote windows associated with this telemetry device must wait their turn. 

Once the connection is made, a complete configuration exchange takes place. The Controller 

transmits a vehicle list and the complete configurations for each of these vehicles to enable the 

Remote to configure its vehicle list and all associated vehicles. The Remote, in turn, transmits 

its local vehicle configuration to the Controller. 

On subsequent re-connections, the vehicle list is transmitted, but the transmission of the 

associated configurations and the transmission by the Remote of its local vehicle configuration 

are skipped. This makes subsequent re-connections more efficient by eliminating the transfer of 

data that is considered to have already been exchanged. Exceptions to this occur in two 

instances. The first is if the Controlled Remote window’s Address button is clicked and the 

resulting dialog is exited using the OK button. In this case, the next re-connection process will 

involve the complete configuration exchange sequence. The second case is when the list of 

vehicles the Remote is tracking is changed. At that time, the new vehicle list is sent and the 

complete configuration for each is sent. 

During the connection and subsequent exchange of configuration data, there are messages that 

are considered to be critical and those that are considered to be non-critical. If the appropriate 

acknowledgment or response is not received from the Remote after three attempts to send data 

or query for data considered to be critical, the connection process is aborted. If this occurs while 

working with messages considered non-critical, the process simply moves on to the next step. 

While connected, the Controller checks the communications once a minute by transmitting a 

“heartbeat” to the Remote, which returns the message to indicate the communications are okay. 

If unsuccessful, this attempt is tried three times each minute before aborting the attempt. If the 

Controller’s attempts to initiate a heartbeat response from the Remote fail for 5 consecutive 

minutes, it disconnects from the Remote. It will try and reconnect every minute after this. 

At the Controller, any changes to the configuration of any vehicle that is being tracked by any 

Remote are automatically transmitted to the Remotes to maintain synchronization. 

Note: when not connected, not all options in the Controlled Remote window are accessible. 

The name of the Remote vehicle associated with a Controlled Remote window is included in 

that window’s title bar. 

To Add and Configure a Controlled Remote in the Controller’s Vehicle List 

All remote vehicles that are to be tracked at the Controller using the information from 

Controlled Remote windows must be added to WinFrog (see the Vehicles chapter).  

There are a few points specific to a Controlled Remote. 

1 In the Configure Vehicle-Devices dialog, set the Data Source to Ctrld Remote. 

No further configuration is required in this dialog, with the exception of devices, if required. 

The only devices that can be added to a controlled remote vehicle at the controller are 

output devices. 
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2 Vehicle Presentation dialog 

The name of the Controlled Remote must be entered here exactly as it is entered at the 

Remote. If this is not done, the data from the associated Controlled Remote window will 

not be associated with this vehicle. 



WinFrog User’s Guide – Controlled Remote Tug Telemetry  14-11 

To Connect to a Remote 

1 From the View menu, choose the Controlled Remote option. 

 

2 Click the Address button and configure the communications protocol and Remote name 

and ID/address. 
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Connection Mode 

Sockets Select this option to use the TCP/IP sockets as 

the communications medium. 

WinFrog Telemetry Select this option to use the WinFrog Telemetry 

device as the communications medium. 

3 Select the appropriate Connection Mode.  

If using Sockets, enter the IP address of the WinFrog Remote computer, e.g. 10.0.0.10. To 

determine the IP address of the Remote, open a DOS window on that computer and type 

ipconfig and press Enter. If the computer is correctly setup for TCP/IP protocol, the IP 

address displays. 

If using the WinFrog Telemetry device, enter the Ship ID as entered for the Remote 

WinFrog’s Telemetry device configuration (see the Multi-Vehicle Positioning & 

Telemetry chapter). The parameter entered here is the address used to identify the WinFrog 

system that is communicated with using this window. 

4 Enter the Remote’s local Vehicle Name. 

The local vehicle at the Remote is generally considered to be the vehicle on which the 

Remote system is installed. In the case of the WinFrog Remote package, this is the only 

local vehicle. In the case of a standard WinFrog operating as the Remote, there may be 

multiple local vehicles. Any of these may be used. 

The name entered is used to identify the vehicle at the Remote that the Controller actually 

connects to. All subsequent vehicle based actions executed from the Controlled Remote 

window are addressed to this vehicle. Position and data transmissions from the Remote to 

the Controller are for this vehicle. 

Note: In the case of multiple local vehicles at the Remote, enter the name of the vehicle that 

is to be tracked at the Controller. If another vehicle is to be tracked at some point of 

operations, disconnect from the Remote, change this entry to the other vehicle and re-

connect.  

Note: The Remote vehicle’s name must be entered exactly as entered at the Remote.  

The Controller uses this name and the name entered for the respective vehicle added to the 

Controller (see the To Add and Configure a Controlled Remote in the Controller’s 

Vehicle List section) to associate the data from the Remote with a vehicle in the 

Controller’s vehicle list. This association enables the Remote vehicle to be displayed for 

monitoring and tracking it in the various windows. 

Note: If the ID/address is correct but there is an error in the vehicle name, the Controlled 

Remote window will connect to the Remote WinFrog system but will be unable to refine 

the connection to the correct vehicle. As a result, the connection will appear to be okay, but 

there will be no communication from the Remote’s local vehicle itself. 

Note: If the Remote vehicle’s name is entered correctly here, but the name of the respective 

vehicle as added to the Controller’s vehicle list does not match this name exactly, problems 

will be encountered. The data will appear in the Remote window correctly and the 

communications with the Remote will operate correctly. However, the Controller will not 

be able to correctly associate the data from the Remote with the vehicle it has added for 

tracking and the position in the Vehicle Text window will be yellow and won’t update. 
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5 Enter a Transmission Repeat Interval. 

When the Controller transmits a query, configuration data, or a file segment, it waits for the 

appropriate response. If it does not get a response within the time interval entered here, it 

repeats the transmission. The process is repeated three times. If the appropriate response is 

not received, the transmission is aborted. The default of five seconds is a reasonable initial 

setting if using the WinFrog Telemetry, though this can usually be reduced to three in 

reasonable conditions. If using sockets, an interval of one second is reasonable. 

6 If using the WinFrog Telemetry for communications, select the WinFrog Telemetry 

Device from the dropdown list. WinFrog supports the use of multiple telemetry devices in 

cells. All telemetry devices added to the Controller are listed here. 

Note: the positions received from a Remote in one cell can be transmitted to a Remote on 

another cell. This permits the use of multiple cells with only a few Remotes in each. The 

fewer the Remotes in a cell, the faster the attainable update rates within that cell. 

Note: Redundancy of telemetry communications can be implemented by using two cells. In 

this scenario, rather than being used to support a large number of Remotes by being located 

on different Remote vehicle groups, they are co-located on vehicles of the same group. All 

TELEMETRY devices at the Remote are checked for messages from the Controller and all 

messages from the Remote to the Controller are sent over all of these same TELEMETRY 

devices. The cell used is the one selected for that Remote at the respective Controlled 

Remote window. It is important to note that while operator intervention is not required at 

the Remote sites, it is at the Controller. When a communication failure with a Remote site is 

noticed, the alternate TELEMETRY device (cell) must be selected at the Controller. If 

detected and acted upon early enough, WinFrog does not even go through the connection 

process as the cells are switched. Only that Remote that is experiencing problems needs to 

be switched.  

7 Click OK to exit. 

Note: if an attempt to connect to a Remote is already in progress after exiting the Address 

dialog box, perform the following corrective steps. 

 - Return to the Address dialog. 

 - Change the Connection Mode from the desired mode. 

 - Click OK to exit. 

 - Return to the Address dialog. 

 - Re-select the correct Connection Mode 

 - Click OK to exit. 

This will reset the connection to the Idle state regardless of what stage it had previously been in. 

8 The list of vehicles being tracked by the Controller and those to be tracked by the Remote 

can be configured now, before attempting to connect to the Remote, or later, after the 

connection is complete. An advantage of doing it before connecting is that if all the vehicle 

configurations are already known (i.e. all the other Remotes have already been connected to 

and interrogated for their configurations), the time consuming process of transmitting the 

configurations is executed at connection time. A disadvantage is that if the vehicle list for 

the Controller is incomplete or the configurations for all the vehicles (including any other 
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Remotes) is incomplete, the current configurations will be sent now and then have to be re-

transmitted as each vehicle configuration is completed. 

If it is desired to edit the Remote vehicle list at this point, refer to the To Edit The 

Remote’s Vehicle List section. 

9 The Status line, in the Controlled Remote window, should indicate Idle. Click the 

Connect button to initiate the connection process. The progress can be monitored by 

viewing the Status, Tx Msg and Rx Msg lines. The appropriate Status line message is given 

here for each stage. For more information concerning the messages given in the Tx Msg and 

Rx Msg lines, refer to the Monitoring the Controller/Remote Communications section. 

The process is as follows: 

 Controller looks for the Remote. Status is Connecting 

 After detecting the Remote, the Controller synchronizes with the Remote. Status 

is Syncing. 

 If the Controller cannot detect the Remote it returns to the Idle state. If this 

occurs, click the Connect button again. If the Remote still cannot be detected, the 

communication settings for the Controller and the Remote must be checked to 

ensure they are correct. An incorrect address and/or Ship ID is often the cause of 

the problem. If using the WinFrog Telemetry, check the I/O Devices window for 

this device to ensure that the telemetry network is operating correctly. 

 The Controller sends the communication parameters to the Remote, including the 

Vehicle List that the Remote is to use. Status is Initializing. 

 The Controller then waits 30 seconds for the Remote to configure its vehicle list. 

Status is Waiting n seconds, where n is the count down from 30 seconds. 

 If the connection is a re-connect after a successful connection has previously been 

made, and no changes to the Address or Vehicle List have been made, the next 

two steps are skipped. 

 The Controller updates the Remote with the configurations of the vehicles in the 

Vehicle List, sent during the initialization stage above. If the list is empty, this 

step is skipped. Status is Updating. 

 The Controller queries the Remote for its complete configuration. Status is 

RqstCnfg. 

 When the Remote’s configuration download is complete, the Controller transmits 

a StartPulse to the Remote and looks for a reply. This message informs both 

systems that the configuration exchange is complete. Status is Starting. 

 When the Controller receives the Remote’s StartPulse reply, the connection 

process is completed. Status is Available. 

Note: When using sockets, many of the stages occur so quickly that the associated status is 

displayed and then replaced by the next stage status in such a fashion that it is not even 

detectable by the operator. 

To Disconnect from a Remote 

1 Click the Disconnect button. 
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2 The Controller transmits a disconnect message to the Remote and awaits a reply. Status is 

Disconnecting. 

3 When the reply to the disconnect message is received from the Remote, the Controller 

changes to the Idle state. Status is Idle. 

4 If after three transmissions of the disconnect message, the Controller has not detected the 

appropriate reply from the Remote, the Controller resets its connection state and changes to 

the Idle state. Status is Idle. 

To Configure the Vehicle List for the Remote 

1 Click the Psn Output button. 
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2 In the Configure Remote Vehicle List dialog, the Local Vehicle List contains the names 

of those vehicles being tracked by the Controller, except the remote vehicle that this 

Controlled Remote window is currently connected to.  

Note: When connecting to a Remote with multiple local vehicles, it is possible to connect to 

and track any of the Remote’s local vehicles and subsequently change this and connect to 

and track a different Remote local vehicle. As a result, it is possible that a local vehicle 

associated with the Remote appears in this list because it is not the one that is currently 

connected to. If this vehicle is inadvertently selected to be tracked by the Remote via the 

Controller, the Remote ignores it and maintains the original local vehicle. 

Any vehicle that is already selected to be tracked at the Remote is highlighted. To select an 

unselected vehicle, click on it in the list and it will become highlighted. To de-select a 

selected vehicle, click on it in the list, and will become un-highlighted. 

3 Click the OK button. 

4 The Controller transmits the vehicle list to the Remote. Status is Initializing. 

5 The Controller waits 30 seconds while the Remote re-configures its vehicle list. Status is 

Waiting n seconds, where n is the count down from 30. 

6 The Controller sends the complete configuration for each vehicle on the list. Status is 

Updating. 

7 The Controller resumes normal communications. Status is Available. 

The position data for four vehicles is sent in any one position transmission by the controller. If 

there are more than four vehicles on the list to be transmitted, they will be cycled through. The 

actual position output rate is determined by the fastest selected Tx Interval for a Remote 

position update rate in any of the Controlled Remote windows sharing the same telemetry 

device. 

If more than one Remote is in a given telemetry cell, the Tx Msg line will indicate the 
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transmission of the position output message in only one of the Controlled Remote windows. 

To Display the Remote Graphics at the Controller 

1 Check the Display This Remote Locally box.  

Any other Controlled Remote window that has this checked is automatically set to 

unchecked. 

 

Checking this box automatically sets the configuration for the Controller’s Graphics1 

window to match the configuration for the same window on the Remote. This enables the 

Controller to monitor what the Remote is seeing. 

Note: this forces the Controller to use the same Graphics1 window configuration, but it 

does not mimic all factors affecting the display of data in the this window, due to the 

limitations of the synchronization of the Controller and the Remotes. For example, the 

Controller’s Graphics1 window displays all vehicles set to be displayed at the Controller, 

whereas the Remote may not even be configured to track all vehicles. As a result, the 

Controller’s Graphics1 window will not be exactly as the Remotes. While in this mode, if 

the Graphics1 window on the Controller has the focus, any toolbar graphic functions, such 

as Zoom In, and any change in the configuration for this window will be transmitted to the 

Remote as if they were accessed directly from the Controlled Remote window via the 

Graphics tab. They will not be applied at the Controller until an acknowledgment of the 

changes transmission has been received from the Remote. 
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To Send a Working File to the Remote 

1 Click the Send File button in the Controlled Remote Window. 

 

2 In the Transfer Working File dialog, select the Working File to transfer to the Remote, 

either pictures, survey lines, or waypoints. 

 

3 Click the OK button. The transfer starts immediately. 

The Controller transmits the file in segments. After transmitting each segment, it waits for 

confirmation that the Remote has received that segment without errors. If necessary, the 

Controller makes three attempts to transmit each segment. If unsuccessful after three attempts to 

send the same segment at any stage in the file transfer, the transfer is aborted. 
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The Status of the process can be monitored with the Tx Msg and Rx Msg lines in the 

Controlled Remote window. The following messages may be found in the status lines: 

Tx Msg :FILE REC n Controller has sent file segment n 

Tx Msg :FILE ABORT Controller has aborted the file transfer 

Rx Msg: FILE Rn CFM Remote has received segment n OK 

Rx Msg: FILE Rn ERR Remote has received segment n with an error, 

Controller will re-transmit this segment. 

Rx Msg :FILE ABORT Remote has confirmed aborted file transfer. 

 

4 At the Remote, when the file transfer is completed, the new file automatically replaces the 

current relevant Working File and is written to the disk. 

Note: In the case of the Working Waypoint file, it is important to note that if a waypoint is 

configured to use a vehicle shape as its icon, the shape information is not included in the 

waypoint file. The vehicle shape is retrieved from the vehicles the respective WinFrog is 

tracking. Therefore, if the Remote has not been configured to track the respective vehicle 

(see To Configure the Vehicle List for the Remote) the vehicle shape is not available and 

the icon used in the Graphic windows defaults to a square. 

To Force an Update of the Configuration of the Vehicles on the Remote’s Vehicle 
List 

1 Click the RemUpdate button. 

 

2 The Controller sends the complete configuration for each vehicle on the list. Status is 

Updating. 
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3 The Controller resumes normal communications. Status is Available. 

To Interrogate the Remote Vehicle Data Type List and Configuration 

1 Click the Sys Config button. 

 

2 The Controller queries the Remote for the list of device data types that are attached to the 

Remote’s local vehicle and their associated configurations. The Tx Msg line will show SYS 

CFG QRY. When the Remote responds, the Rx Msg line will show ITM TYPE. 

3 The data types attached to the vehicle are listed in the list window to the left of the status 

lines. 

To Query the Remote Vehicle and System for Configurations 

1 Select the tab associated with the data of interest. 

2 Click the Query button. 

3 The Controller sends the associated query message to the Remote. This is indicated in the 

Tx Msg line. 

4 The Remote responds by sending the configuration data to the Controller. This is indicated 

in the Rx Msg line. 

5 The information in the tab is updated accordingly. Further review of the configuration is 

possible by clicking the Config button (see the To Configure the Remote Vehicle and 
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System section). 

To Set the Remote’s Data Transmission Rate 

1 Select the tab associated with the data of interest. 

2 Click the Tx Interval button. 

 

3 Enter the desired update rate in seconds. 

Note: it is important that the update rate is not set at a rate that exceeds the communications 

mode. To enhance the performance of the Controlled Remote feature, only that data that are 

required should be transmitted by the Remote back to the Controller. 

4 Click OK. 

5 The Controller sends a communication configuration message to the Remote. This is 

indicated in the Tx Msg line with COM CFG UPD. 

6 The Remote sends a confirmation message back to the Controller. This is indicated in the 

Rx Msg line with COM CFG UPD. 

Monitoring and Configuring the Remote Vehicle and 
Graphics 
The tabs in the Controlled Remote window and their associated buttons below them enable 

you to view specific information about the Remote vehicle and graphics and query and 

configure the Remote with respect to the data type tab selected. 
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To Configure the Remote from the Controlled Remote Window 

1 Click the tab for the appropriate data, then click the Config button. 

The associated configuration dialog will appear. This reflects the associated configuration at 

the Remote. This is an important point as there are several areas where this may result in 

confusion if this is not considered. 

If you click the OK button to exit the Configuration dialog, the appropriate configuration message 

is transmitted to the Remote. The change is not reflected at the Controller until it has received a 

confirmation from the Remote that the configuration message was received and implemented. At 

this time, the changes are made at the Controller as well. The changes are then transmitted to all 

Remotes. 

If a configuration message is not acknowledged by the Remote after three attempts, the 

configuration is aborted. No message is currently presented to you with this information. 

Therefore, any attempt at re-configuring a Remote must be monitored during the 

communications process to ensure it was successful. The status of the communications can be 

monitored in the Tx Msg and Rx Msg lines. It can also be checked by re-accessing the 

associated configuration dialog. If the Remote acknowledged the configuration, the changes 

will be present in the configuration dialog. If not, the configuration settings will have reverted 

to their original state. 

Note: the configuration for the Remotes can also be manipulated from the standard WinFrog 

locations when the Remote vehicle is selected. For example, from the Vehicle Text window 

displaying a Remote vehicle, use the right mouse button to access the pop-up menu and select 



WinFrog User’s Guide – Controlled Remote Tug Telemetry  14-23 

Configure Offsets. Changes made here are transmitted to the Remote. They will then be 

reflected at the Controller once confirmation has been received from the Remote that the 

configuration change was received and implemented. There are exceptions to this. These will be 

discussed later in this section. 

The individual configuration dialogs will not be discussed here unless there are specific points 

that require comment. Refer to the appropriate chapters for information on the associated 

configurations. 

To Interrogate the Remote from the Controlled Remote Window 

1 Click the tab for the appropriate data, then click the Query button. 

The Controller sends an interrogation to the Remote, which, in turn, will reply with the 

appropriate configuration data. The query will be repeated three times if an appropriate 

reply is not received from the Remote. If still unsuccessful, the query is aborted. Note: there 

is not a message to advise you that the query is aborted, so you should monitor the query 

process to ensure it is successful. 

Note: to set the data transmission rate for the Remote from the Controlled Remote window, 

see the To Set the Remote’s Data Transmission Rate section. Only the Position, Data, and 

Event tabs have an associated Tx Interval button. 

The following details the available tab displays and the associated configuration, query, and 

transmission if comments are required. 
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Position Tab 

Displays the position information for the Remote if the associated Tx Interval has 

been set such that the Remote is transmitting the position data back to the 

Controller. 

 

The display includes: 

 The time of the position and the age of the data used for the position at the 

Remote. 

 Latitude and longitude in the Remote’s local ellipsoid complete with the 

standard deviation (from the Kalman Filter). 

 Velocity North and East vectors with the standard deviations (from the Kalman 

Filter). 

 Elevation 

 Heading 

 Water Depth 

 Position status LED indicating the status at the Remote. If the age of the data 

exceeds 15 seconds the LED is yellow; if the age exceeds 30 seconds, the LED 

is red. In addition, if the age exceeds 30 seconds an audible alarm sounds. This 

is acknowledged by clicking the red button in this tab. 
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If you click the Config button while this tab is displayed, the Configure Vehicle-

Devices dialog opens. This operator interface is susceptible to incorrect 

configuration. There are several important aspects to this configuration. 

 

Notice that although the Data Source is set to Real-Time, there are no devices displayed. It is 

important that you do not try to add devices (click the Add button) from this dialog. If data 

types are added, the information is not transmitted to the Remote because this capability is not 

supported by the Remote Control feature. However, they will remain in the list adding 

confusion to the operation that is really occurring. 

Changing the Data Source results in the change being implemented at the Remote and causes 

the Remote vehicle to stop positioning correctly. Do not change this setting. 

The configuration information in the Position, Kalman Filter, Velocity Filter, and Range 

Gate panels are the configuration items intended to be manipulated from the Controller. 

It is also important to note that when the Configure Vehicle-Devices dialog is accessed from any 

other part of the Controller, such as via the right-click in the Vehicle Text window (when the 

Remote vehicle is displayed), it does not send a configuration message to the Remote when exited 

with the OK button. It does display the current settings of the Position, Kalman Filter, Velocity 

Filter, and Range Gate panels at the Remote. If these settings are changed here, the Remote is not 

changed, but the same dialog accessed via the associated Controlled Remote window will show 

these new settings. Therefore, do not change the settings of the Position, Kalman Filter, Velocity 

Filter, and Range Gate panels from here for a Remote. The Configure Vehicle-Devices dialog 

accessed from anywhere but the Controlled Remote window is only for the designating the vehicle 

as a Ctrld Remote and adding output devices as required (see the To Add and Configure a 

Controlled Remote in the Controller’s Vehicle List section). 
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Data Tab 

Displays the raw data for the Remote if the Tx Interval associated with this tab has been set 

such that the Remote is transmitting the raw data back to the Controller. The specific data 

displayed are controlled by selecting a data type in the Data Type List in this window. The 

display is the same format used in the Calculations Window for Data Item Text. 

Note: the transmission of raw data is given a lower priority by the Remote than any other 

data being transmitted. As a result, the update rate for the raw data may not be as high as set 

using the Tx Interval button. The viewing of the raw data is intended for troubleshooting 

the Remote system. If required, the position transmission interval for the Remote should be 

set to 0 seconds (off) and only the data set to transmit. 

 

The configuration for the data type is accessed by clicking the Config button when the data 

tab is displayed. The configuration (and Query if clicked) is for the data type displayed at 

the time the button is clicked. The configuration for the data types at the Remote are only 

accessible from here. The configuration dialogs accessed are the same as those accessed for 

the data types via the Configure Vehicle-Devices dialog when a data type is highlighted 

and the Edit button is clicked. 

Note: If the Remote has the position auto-switching feature on, the display of the 

primary/secondary usage status of each POSITION data item in the Data Tab may be 

incorrect if switching has occurred. This is because the status is sent only when new data for 

each item is transmitted. To verify which is being used as the primary, temporarily switch 

on transmission of the data item from the remote and note if the data is updating. If so, then 

the status is correct. 

The data transmission rate set by clicking the Tx Interval button controls the transmission of 

the raw data for all data types, not just the one displayed at the time. 

Offsets Tab 

Displays the current vehicle offset selected for the Remote. 
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The configuration of the offsets for the Remote can be accessed from here or anywhere else 

offsets are configured at the Controller (i.e. from the Vehicle Text window when the Remote 

vehicle is displayed, use the right mouse button to access the pop-up menu and select the 

Configure Offsets option) with the same results. 

Wpt Tab 

Displays the active waypoint and waypoint tracking information for the Remote. 

 

The configuration of the active waypoint for the Remote can be accessed from here 

or anywhere else a waypoint can be selected at the Controller (i.e. from the Vehicle 

Text window when the Remote vehicle is displayed, use the right mouse button to 

access the pop-up menu and select the Setup Waypoint Tracking option) with the 

same results. 

When a waypoint is selected, the waypoint tracking configuration and the 

associated waypoint data are transmitted to the Remote. Therefore, the Remote’s 

Working Waypoint file does not need to be synchronized with the Controller in 

order to configure the waypoint tracking for the Remote. The waypoint file 

accessed when selecting a waypoint at the Controller for the Remote is, in fact, the 

Controller’s Working Waypoint file. 

Note: The exception is the case of the waypoint selected for tracking being 

configured to use a vehicle shape as the icon. The respective vehicle shape is not 

included in the waypoint data transmitted to the Remote, it is retrieved from the 

current vehicle list for the respective WinFrog. Therefore, if the Remote has not 

been configured to track the respective vehicle (see To Configure the Vehicle List 

for the Remote) the vehicle shape is not available and the icon used in the Graphic 

windows defaults to a square. 

Line Tab 

Displays the active line name and line tracking information for the Remote. 
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The configuration of the active line for the Remote can be accessed from here or 

anywhere else a track line can be selected at the Controller (i.e. from the Vehicle Text 

window when the Remote vehicle is displayed, use the right mouse button to access the 

pop-up menu and select the Setup Line Tracking option) with the same results. 

When a line is selected, the line tracking configuration and the associated line data 

are transmitted to the Remote. Therefore, the Remote’s Working Survey Line file 

does not need to be synchronized with the Controller in order to configure the line 

tracking for the Remote. The line file accessed when selecting a line at the 

Controller for the Remote is, in fact, the Controller’s Working Survey Line file. 

Events Tab 

Displays the event status and data for the Remote. If the remote vehicle is not set as 

the primary event vehicle then the Configuration and Query buttons are disabled. 

The Start Events and Stop Events buttons are located directly within this tab if the 

Events are enabled or active, respectively. 
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The configuration of the Eventing at a Remote requires two stages of configuration 

communications, the first to setup the eventing parameters and the second to define 

and create the appropriate files. If either fails, the event configuration aborts. 

The actual configuration is the same as if being executed for a local vehicle. Refer 

to the Eventing chapter. The starting and stopping of the events is controlled via 

the buttons that are shown in this tab at the appropriate stages of event setup and 

execution. These mimic those in the standard WinFrog toolbar. 

It is important to note that even the though the event data can be sent by the Remote 

back to the Controller, it is only logged at the Remote. 

Note: the eventing configuration accessed here is for the Remote only. Eventing 

configuration accessed anywhere else at the Controller is for the Controller system. 

The two are independent, including the setting of the Event states of Off, Primary, 

and Secondary in the Vehicle Presentation dialog. 

Note: if the Remote is a WinFrog Remote package instead of WinFrog with the 

Remote module, it does not support Eventing. In this case, when the Events Tab is 

selected, the statement This Remote Vehicle does not support Eventing. is displayed 

in the tab and the Config, Query and Tx Interval buttons are disabled.  

Note: The option to select the event file format version to use for logging is 

configurable from the Controller if the Remote supports the option (i.e. standard 

WinFrog with the Remote module, v 3.7 and later). In this case, the Event 

Configuration dialog that is opened when the Config button is clicked from this tab 

includes a Format Version button. Clicking this accesses the Event File Format 

Options dialog (see Specifying the Event File Format in the Eventing chapter). If 

the Remote does not support this option (pre v3.7), this button is disabled. 

Note: When entering the event file name from the Event Secondary 

Configuration dialog, the Controller does not know the respective folder path so it 

cannot inform the operator of the maximum allowed file name length. If the total 

length of the file path and name is determined by the Remote to exceed the 

maximum allowed length, this information is passed back to the Controller. A 

message informing the operator of this is displayed and the event setup is aborted. 

Note: the Controlled Remote Event configuration does not support the 

configuration and control of MBES data logging at the Remote even if that site is 

running WinFrog with the MBES Data Logging module. 

Graphics Tab 

Displays the Graphics1 window configuration basics for the Remote. There are 

also Zoom In, Zoom Out, and Pan buttons located directly in this tab to directly 

control the Remote. 
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Note: The configuration and manipulation of the Remote’s Graphics1 are only 

possible from here (unless the Display This Remote Locally checkbox is checked). 

In this case, any action and configuration executed on the Graphics1 window at the 

Controller acts directly on the Remote Graphics1 window. 

Vehicle Cfg Tab 

Displays the basic vehicle presentation configuration for the Remote, including a 

rectangle displaying the current vehicle color. The associated configuration dialog 

is Vehicle Presentation. 

 

The configuration of the Vehicle Presentation for the Remote can be accessed from 

here or anywhere else a track line can be selected at the Controller (i.e. from the 

Vehicle Text window when the Remote vehicle is displayed, use the right mouse 

button to access the pop-up menu and select the Vehicle Presentation option) with 

the same results. 

The exception to this is as follows: 

The manipulation of the Event Generation settings is associated with where this 

dialog is opened. If opened from the Controlled Remote window, these settings 

affect the Remote vehicle at the Remote. If opened from anywhere else at the 

Controller (i.e. from the Vehicle Text window when the Remote vehicle is 

displayed, use the right mouse button to access the pop-up menu and select the 

Vehicle Presentation option) these settings affect the Remote vehicle at the 

Controller. Therefore, the Event Generation settings at the Controller and the 

Remote are independent. 

It is important to note that the name of the Remote can be changed from this dialog. 

If this is done, the name entered for the Remote Vehicle Name for the associated 

Controlled Remote window (see the To Connect to a Remote section) must be 



WinFrog User’s Guide – Controlled Remote Tug Telemetry  14-31 

changed to reflect this. Otherwise, though the connection to the Remote WinFrog 

will remain operational, communications with the Remote vehicle will cease. 

Vehicle Shape Tab 

Displays the vehicle shape type for the Remote. The configuration associated with 

this tab is the Configure Vehicle Outline dialog. 

 

The configuration of the Configure Vehicle Outline for the Remote can be 

accessed from here or anywhere else a track line can be selected at the Controller 

(i.e. from the Configure Vehicles dialog when the Remote vehicle is highlighted, 

click the Configure Vehicle Outline button) with the same results. 

Monitoring the Controller/Remote Communications 

The Connection Status lines display the status of the Controller/Remote connection plus 

current activity. The second to fourth lines in the top right hand corner pertain to OBC Seismic 

operations. The remaining status lines are general. 
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Vehicle The name of the Vehicle to which the Controlled 

Remote window is configured to connect. 

Activity The current seismic-related operation in which 

the Remote vehicle is currently involved. 

Patch The name of the patch in which the Remote 

vehicle is working. 

In Sync The status of the synchronization of the 

Controller and the Remote with respect to the 

seismic line set. 

Status The connection state in which the system is 

currently. The possible states are listed here. The 

first 5 states listed are associated with the 

unconnected and connecting stages. The 

remaining items are associated with the 

connected stage. 

Idle The connection is idle, no communications are 

being attempted. 

Waiting For Address There was an error in the sockets connection, the 

socket is waiting for an address. 

Connecting The connection with the Remote WinFrog 

system is underway. 

Connected The connection with the Remote WinFrog 

system has been made. 

DisConnecting The Controller is disconnecting from the Remote. 

Idling The controller is waiting to connect. 

Syncing The controller has connected and is now 

synchronizing with the Remote.  

Initializing The controller is sending the connection 

configuration to the Remote to initialize the 

communications. It also sends the list of vehicles 

to be tracked by the Remote at this point. 

Waiting n seconds The controller waits for 30 seconds while the Remote 

sets up its vehicle list and initializes each vehicle. 

Updating The controller sends the configuration for all the 

vehicles that the Remote is to track. 

RqstCnfg The controller requests the Remote vehicle’s 

configuration. 

Starting The controller sends a start pulse to the Remote 

to tell it that the controller is ready to proceed 

after the connection process and exchange of 

configurations is completed. The Remote 

responds in like. 

Available Indicates the connection has been successfully 

made including the exchange of the start pulses 

and communications are operating normally. 

Confirming Periodically the Controller confirms the 

connection by sending a Heartbeat to the 

Remote and the Remote responds in like. 
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Tx Msg Displays the last message type transmitted via this 

window and the time it was sent to the transmit 

queue. The message can be any of the following: 

Waiting to Connect Another window is trying to connect, this 

window is waiting its turn. 

DISCONNECT Disconnect message. 

CONNECTING Connect message. 

COM CFG UPD Communication configuration message. 

SYS CFG QRY Querying the Remote vehicle data types. 

VEH CFG QRY Querying the Remote vehicle configuration. 

VEH SHP QRY Querying the Remote vehicle shape. 

VEH O/S QRY Querying the Remote vehicle offset 

configuration. 

PSN CFG QRY Querying the Remote vehicle position 

calculation configuration. 

ITM CFG QRY Querying the Remote vehicle data types 

configuration. 

LIN CFG QRY Querying the Remote vehicle line tracking 

configuration. 

WPT CFG QRY Querying the Remote vehicle waypoint tracking 

configuration. 

GRF CFG QRY Querying the Remote WinFrog Graphics1 

window configuration. 

EVT CFG QRY Querying the Remote vehicle eventing 

configuration. 

STARTPULSE Startpulse message to instruct the Remote 

WinFrog to start normal communications. 

HEARTBEAT Heartbeat sent by the Controller to confirm 

communications with the Remote WinFrog are 

still okay. 

FILE ABORT The Working File transfer has been aborted due 

to no response from the Remote WinFrog 

confirming receipt of file segments. 

VEH SHP UPD New Remote vehicle shape configuration sent to 

the Remote WinFrog. 

OTH VEH UPD New configuration affecting one of the vehicles 

tracked by the Remote sent to the Remote. 

ANC STE UPD New anchor status for any vehicle sent to the 

Remote. 

PSN CFG UPD New Remote position calculation configuration 

sent to the Remote. 

LIN CFG UPD New Remote vehicle line tracking configuration 

sent to the Remote. 

WPT CFG UPD New Remote vehicle waypoint tracking 

configuration sent to the Remote. 

VEH O/S UPD New Remote vehicle offset configuration sent to 

the Remote. 
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VEH CFG UPD New Remote vehicle presentation configuration 

sent to the Remote. 

GRF CFG UPD New graphics configuration sent to the Remote. 

EVTs UPD New Remote vehicle event configuration sent to 

the Remote, where s is one of the following: 

DSB Disabling eventing. 

CFG Configuring eventing  

ENB Enabling eventing 

STR Starting eventing 

ACT Activating eventing 

STP Stopping eventing 

ITM CFG UPD Remote vehicle data type configuration sent to 

the Remote. 

FIL REC n Working File segment sent to the Remote, where 

n is the segment number. 

GRF UPD CFD Confirmation of new Remote graphics configuration 

confirmation sent by the Remote to the Controller, 

sent to the Remote. 

PSN DATA Vehicle position data message sent to the Remote. 

VCF n UPD Vehicle presentation configuration (other than 

the Remote) sent to the Remote, where n is the 

vehicle number. 

VSH n UPD Vehicle shape configuration (other than the 

Remote) sent to the Remote, where n is the 

vehicle number. 

VFL n UPD Vehicle fairlead configuration (other than the 

Remote) sent to the Remote, where n is the 

vehicle number. 

VAN n UPD Vehicle anchor state and configuration (other 

than the Remote) sent to the Remote, where n is 

the vehicle number. 

Rx Msg  Displays the last received message type received 

from the Remote associated with this window and 

the time it was taken from the receive queue.  

 

These can be any of the following: 

CONNECTING Confirms connecting process started. 

HEARTBEAT Heartbeat received, response to one sent by the 

Controller, confirms communications are okay. 

STARTPULSE Startpulse message, response to one sent by the 

Controller to indicate Remote is ready for 

normal communications. 

ENDWAITING Confirms Controller can stop waiting for the 

Remote to configure its vehicle list. 
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DISCONNECT Confirms the disconnect message sent by the 

Controller was received. 

FILE ABORT Confirms the aborting of the file transfer as 

initiated by the Controller. 

FIL Rn CFM Confirms the file segment n was received. 

FIL Rn ERR Error in the file segment n was detected. This 

segment is re-sent by the Controller. 

ALARM DATA Alarm data. 

GRF DATA Graphics1 configuration. 

EVT SP# DATA Specific Event data, i.e. the data for the last 

event generated by the Remote. 

EVT DATA General Event configuration data. 

EVT START Eventing started. 

EVT s CFD Eventing configuration stage confirmed, where 

the stage is indicated by s, which can be one of 

the following: 

DSB Disabling eventing. 

RCT Initial configuration, actual eventing 

parameters. 

CFG Secondary configuration, event file 

parameters. 

ENB Enabling 

STR Starting 

STP Stopping 

DSB Disabling 

COM CFG CFD Confirms communications configuration was 

received. 

GRF CFG CFD Confirms Graphics1 configuration was received. 

VCF CFD Confirms other vehicle presentation 

configuration was received. 

VFL CFD Confirms other vehicle fairlead configuration 

was received. 

VSH CFD Confirms other vehicle shape configuration was 

received. 

AST CFD Confirms other vehicle anchor status 

configuration was received. 

PSN DATA Remote vehicle’s Position data. 

ITEM DATA Remote vehicle’s data type raw data. 

VEH O/S CFG Remote vehicle’s offset configuration. 

PSN CFG Remote vehicle’s position calculation 

configuration. 

VEH CFG Remote vehicle’s presentation configuration. 

VEH SHP Remote vehicle’s shape configuration. 

WPT DATA Remote vehicle’s waypoint tracking configuration. 

LIN TRK DATA Remote vehicle’s line tracking configuration. 
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LIN DATA The line data for the Remote vehicle’s track line. 

ITM TYPE Remote vehicle’s data type list. 

ITM CFG DATA Remote vehicle’s data type configuration. 

PSN CFG CFD Confirms Remote vehicle’s position calculation 

configuration received. 

WPT CFG CFD Confirms Remote vehicle’s waypoint tracking 

configuration received. 

LIN TRK CFD Confirms Remote vehicle’s line tracking 

configuration received. 

LIN DAT CFD Confirms line data for Remote vehicle’s line 

tracking received. 

ITM CFG CFD Confirms Remote vehicle’s data type 

configuration received. 

VEH CFG CFD Confirms Remote vehicle’s presentation 

configuration received. 

VEH O/S CFD Confirms Remote vehicle’s offset configuration 

received. 

VAN STE CFD Confirms Remote vehicle’s anchor status 

configuration received. 

VEH SHP CFD Confirms Remote vehicle’s shape configuration 

received. 

Remote Control and Anchor Handling Operations 
The Remote Control feature is closely linked with the Anchor Handling window. 

All changes in the fairlead and anchor status caused by a Pick, Drop, Edit, or Reset function 

executed from this window at the Controller is immediately transmitted to all Remote vehicles. 

Thus, all Remotes are able to display the fairleads and anchors graphically in real-time, 

including the designation of live anchors. In addition to improving the coordination of 

operations, it also provides a safety benefit. 

This window also enables target data to be sent to the Remotes. When the Tx function is 

executed from the Anchor Handling window, the target information is sent to all Remotes 

where it is automatically set as the respective vehicle’s Active Waypoint and displayed 

graphically as a bull’s eye with 3-meter rings. 

Operating Restrictions 
There are some restrictions to the use of the Remote Control feature: 

 Remote control of the graphics does not extend to the charting capabilities. 

 When configuring the position information of a remote, only the position and height, 

Kalman Filter and median filter controls, dead reckoning and gating are to be 

controlled. Enforced restrictions for these items is not yet implemented. 

 Vehicle Offset names are not displayed at the remote. 

 Anchor names are not transmitted or displayed at the remote 

 


